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Preface

This document describes how to install and configure the Nortel Networks 
LinkPlexer 1.1 application. 

Before you begin

This guide is designed to be read by the following:

• Nortel Networks customers

• Nortel Networks personnel 

• Nortel Networks distributors 

This guide assumes familiarity with the following:

• Microsoft Windows NT 

• TCP/IP networking concepts such as IP address, subnet mask and port 

• CompuCall or ICM on DMS or MSL-100 switches
LinkPlexer 1.2 Installation and Configuration Guide
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Text conventions

This guide uses the following text conventions:

angle brackets (< >) Indicates that the reader chooses the text to enter based 
on the description inside the brackets. Do not type the 
brackets when entering the command.
Example: If the command syntax is
ping <ip_address>, you enter
ping 192.32.10.12

bold Courier text Indicates command names and options and text that 
you need to enter.
Example: Use the dinfo command. 
Example: Enter show ip {alerts|routes}.

braces ({}) Indicates required elements in syntax descriptions 
where there is more than one option. The reader may 
choose only one of the options. Do not type the braces 
when entering the command.
Example: If the command syntax is
show ip {alerts|routes}, you must enter either
show ip alerts or show ip routes, but not both.

brackets ([ ]) Indicates optional elements in syntax descriptions. Do 
not type the brackets when entering the command.
Example: If the command syntax is
show ip interfaces [-alerts], you can enter
either show ip interfaces or 
show ip interfaces -alerts.

ellipsis points (. . . ) Indicates that the reader repeat the last element of the 
command as needed.
Example: If the command syntax is
ethernet/2/1 [<parameter> <value>]... ,
you enter ethernet/2/1 and as many
parameter-value pairs as needed.
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Related publications

For more information about the LinkPlexer 1.1, refer to the following publications 
(you can find most documents listed in the Customer Support section at 
www.nortelnetworks.com):

• Nortel Networks Symposium Call Center Server and DMS Switch Guide, (part 
number 911815).

• Nortel Networks Symposium Call Center Server Installation and 
Configuration guide (part number PO910112).

• ICM TAPI Network Managers Guide (part number PO881940)

• Peri Link Server Installation Guide

• MIS-Q218-1 SCAI Interface Specification

• CompuCall Interface Specifications, refer to http://triweb/ACD/icm/
ICM.html

italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is tw
or more words, the words are connected by an 
underscore.
Example: If the command syntax is
show at <valid_route>, valid_route is one
variable and you substitute one value for it.

plain Courier 
text

Indicates command syntax and system output, for 
example, prompts and system messages.
Example: Set Trap Monitor Filters

separator ( > ) Shows menu paths. 
Example: Protocols > IP identifies the IP command o
the Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not typ
the vertical line when entering the command.
Example: If the command syntax is
show ip {alerts|routes}, you enter either
show ip alerts or show ip routes, but not
both.
LinkPlexer 1.2 Installation and Configuration Guide
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Hard-copy technical manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www.nortelnetworks.com/documentation URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe Acrobat 
Reader to open the manuals and release notes, search for the sections required, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

The selected documentation sets, CDs, and technical publications can be 
purchased through the Internet at the www1.fatbrain.com/documentation/nortel/ 
URL.

How to get help

If a service contract for your Nortel Networks product has been purchased from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

http://www.nortelnetworks.com/documentation
http://www.adobe.com
http://www.adobe.com
http://www1.fatbrain.com/documentation/nortel/
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Chapter 1
Overview

This chapter is an overview of the architecture and features of LinkPlexer 1.2. It 
contains the following sections:

• “LinkPlexer 1.2 Architecture” ‚ next

• “Features” on page 17

• “Benefits” on page 22

• “Considerations & Limitations” on page 23

• “Engineering Guidelines” on page 25

 LinkPlexer 1.2 Architecture

LinkPlexer 1.2 is a Windows 2000 application that enables multiple IP clients
share the same session and DMS/MSL-100 resources, by acting as a proxy 
between the two. LinkPlexer 1.2 can connect to the switch via IP (ICM) or X.
(CompuCALL). When LinkPlexer 1.2 acts as an IP capable server it allows 
applications that can only connect via IP to communicate with a switch that u
an X.25 connection.

LinkPlexer 1.2 allows applications to share DN (Directory Number) associatio
between different eBusiness applications.

For example:

• Interactive Voice Response (IVR) voice ports controlled by IVR and 
monitored by Symposium Call Center Server (SCCS)

• A system where, SCCS performs the call routing, the IVR controls the vo
response system, and TAPI Symposium Server/Symposium Agent contro
softphones and screen pops
LinkPlexer 1.2 Installation and Configuration Guide
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ty 
• When agent positions are controlled by TAPI Server/Symposium Agent 
(TAPI) (or desktop CTI) and monitored by SCCS

• In systems where call queues and agent positions monitored by third par
applications, such as voice recorders

Figure 1 describes the general architecture of LinkPlexer 1.2. 

Figure 1   General architecture diagram

In Figure 1 CLAN refers to the Customer LAN; Ethernet refers to the ELAN.
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Figure 2 describes the architecture for LinkPlexer 1.2, SCCS and TAPI

Figure 2   LinkPlexer 1.2, SCCS & TAPI

Features

The main features of LinkPlexer 1.2 are described in the following sections:

• “DN association sharing” ‚ next 

• “ICM application multiplexing” on page 18

• “Connectivity of ICM client to Compucall” on page 18

• “Messaging” on page 18

• “DN Association Management” on page 19

• “Client connection management” on page 20

• “Generation of dv-Set-Offhook-U on behalf of Softphone” on page 22
LinkPlexer 1.2 Installation and Configuration Guide
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DN association sharing

Both CompuCALL and Intelligent Call Management (ICM) limit the association 
of resources to a single session. Two host applications with simultaneous 
CompuCALL/ICM application sessions established with a given switch cannot 
have the same resource associated with the two sessions at the same time. 

LinkPlexer 1.2 overcomes this limitation by propagating all resource messages 
from the DMS/MSL-100 to all clients. 

For example:

A dv-call-offered message from the DMS/MSL-100 is propagated to all clients 
and not just the client that originally issued the dv-dn-association request.

ICM application multiplexing

The DMS/MSL-100 only allows one resource to be associated per link session 
with the switch. However, LinkPlexer 1.2 acts as a proxy server between multiple 
ICM applications and a DMS, MSL-100 CompuCALL, or ICM switch link. It 
enables ICM clients to share, via TCP/IP, the same session and DMS/MSL-100 
resources and manages messages to and from the switch. 

Connectivity of ICM client to Compucall

LinkPlexer 1.2 supports a single connection to the DMS/MSL-100 switch, either   
Ethernet TCP/IP or X.25. This connection allows ICM-only applications to access 
CompuCall-equipped systems. LinkPlexer relays messages to the X.25/ICM link 
on the switch

Messaging

LinkPlexer 1.2 has three general types of messaging and tracks each message 
from an application to the DMS/MSL-100. The initial response message is sent 
only to the sending application. Event messages are broadcast to all connected 
applications.
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To the application communicating with LinkPlexer 1.2 the socket exactly 
emulates the DMS/MSL-100 ICM interface.

DN Association Management

LinkPlexer 1.2 keeps a track of which DNs and Agent Position IDs are associated 
with each agent/client (e.g. SCCS, TAPI etc.) connection. This is required to 
ensure that DNs and Agent Position IDs associated with a particular agent/client 
connection are not disassociated by a dv-Dn-Associate (delete) being received 
from another agent/client connection.

LinkPlexer 1.2 will only forward dv-DN-Associate (add) messages to the DMS/
MSL-100 when the DN/Agent Position ID is not currently associated by 
LinkPlexer. If it is already associated LinkPlexer will simply send a 
RETURN-RESULT message back to the requesting agent/client.

LinkPlexer 1.2 will only forward dv-DN-Associate (delete) messages to the DMS/
MSL-100 when the requesting agent/client is the last agent/client referencing the 
DN/Agent Position ID. If another agent/client is currently referencing the DN 
Agent Position ID a RETURN-RESULT is sent back to the requesting agent/client 
without forwarding the message to the DMS/MSL-100.

When the last client application disconnects, LinkPlexer 1.2 will drop and 
re-establish the connection to the DMS/MSL-100. This will guarantee 
synchronisation between the device list maintained by LinkPlexer 1.2 and the 
devices acquired on the DMS/MSL-100 link.

Known Limitations

The DMS/MSL-100 resources must be configured to ensure uniqueness between 
DNs and agent positions ids. The operation of DN Association Management will 
not be guaranteed for those DN and Agent positions that are not guaranteed 
unique. The define operation of the dv-DN-Association will not be supported. 
Where the operation is used LinkPlexer 1.2 will not guarantee DN Association 
Management. Neither SCCS nor ICM TAPI utilise the define operation.
LinkPlexer 1.2 Installation and Configuration Guide
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The management of CDN state (DEFAULT, CONTROLLED, REVERT TO 
DEFAULT) is outside the scope of DN Association Management, i.e. all 
dv-set-CDN-state messages are passed to the DMS/MSL-100 without being 
processed. This implies that LinkPlexer 1.2 may permit an application to take 
control of a CDN that is controlled by another client.

Session Management

Session Management is carried out by LinkPlexer 1.2 and operates as follows:

• On LinkPlexer 1.2 service startup a connection is established with the sw
and a login session is started (by sending a dv-Appl-Logon message).

• When the last agent/client disconnects from LinkPlexer 1.2, the link betw
LinkPlexer 1.2 and the switch is also disconnected. After a short period (l
than 10 seconds) LinkPlexer 1.2 will re-establish the connection to the 
connection to the switch and restart the login session (by sending a 
dv-Appl-Logon message).

Client connection management

LinkPlexer 1.2 manages all client connections. A client connection is any 
successful socket connection to LinkPlexer 1.2. Each connection uses one c
license. The number of client connections is limited, by the keycode, to 150.

LinkPlexer 1.2 maintains the integrity of the connection between the LinkPlex
1.2 server and each connected client. This allows LinkPlexer 1.2 to:

• Free the client license when a client disconnects

The client connection integrity is maintained at the ICMP level and the 
application level. These are described in the following sections:

• “ICMP connectivity checking” ‚ next

• “Application-level connectivity checking” on page 21

ICMP connectivity checking

To enable ICMP connectivity checking, set the parameters in the DMSGloba
files to the following values:
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• <AgentPingTest=ON>

This setting turns on ICM connectivity checking. The default value is OFF

• <AgentPingInterval=120>

This specifies a 120 second time period between checks. The default val
120 seconds.

If specific values are not set for these parameters, LinkPlexer 1.2 uses the d
values.

Application-level connectivity checking

To enable application-level connectivity checking, set the AgentContinuityTes
parameter in DMSGlobal.ini file to the following value:

• AgentContinuityTest=ON

With this parameter turned on, LinkPlexer:

• Forwards the message to the Session Manager (Internal or External)

• Forwards the message to all connected LinkPlexer agents

• On receipt of a timely reply from the Session Manager, a positive 
acknowledgement (RETURN-RESULT) is sent to the DMS.

• Any agents that don’t respond to the message in a timely fashion are 
disconnected and the agent licence becomes available.

• If the session Manager doesn’t respond the Session Manager Connec
the DMS Connection and connections to all active agents are 
disconnected.

If specific values are not set for these parameters, LinkPlexer 1.2 uses the de
value i.e.:

• AgentContinuityTest = OFF

With this parameter set to OFF, LinkPlexer:

• Forwards the message to the Session Manager (Internal or External)

• On receipt of a timely reply form the Session Manager, a positive 
acknowledgement (RETURN-RESULT) is sent to the DMS
LinkPlexer 1.2 Installation and Configuration Guide
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• If the session Manager doesn’t respond the Session Manager Connec
the DMS Connection and connections to all active agents are 
disconnected.

Generation of dv-Set-Offhook-U on behalf of Softphone

LinkPlexer 1.2 enables multiple applications to monitor and control devices o
single link. In the direct-connect to the DMS/MSL-100 scenario (no LinkPlexe
1.2) the application always has knowledge of the operations being performed
device since the application is responsible for instructing the DMS/MSL-100 
perform the operation. With LinkPlexer 1.2, an application can initiate an 
operation on a device that negatively impacts another application on the link.

While this is a rare scenario, an instance has been identified when using TAP
enabled softphone. When a physical phone-set is used to make the outbound
dv-set-offhook-U-message is sent by the DMS/MSL-100 at the time the phys
phone goes off-hook. However, when TAPI is used to make the outbound ca
dv-set-offhook-U message is generated.

The off-hook message is used by SCCS to update the real-time display. The
of data on the real-time display means that call centre supervisors have 
insufficient information on an agent to differentiate agents who are Not Read
from agents who are an outbound calls.

LinkPlexer 1.2 has implemented a feature whereby it generate a dv-set-offho
message when it receives a the RETURN-RESULT reply from the dv-make-c
request. The message is sent all connected applications. Refer to “Appendix F: 
Softphone Message Sequence Chart” on page 125 for the relevant Message 
Sequence Chart.

Benefits

The main benefits of LinkPlexer 1.1 are described in the following sections:

• “Migration” ‚ next

• “Connectivity” on page 23

• “Compatibility” on page 23
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Migration 

LinkPlexer 1.1 facilitates the introduction of Nortel applications (such as SCCS) 
into existing customer CompuCall or ICM-based networks without the need to 
displace the existing applications. LinkPlexer 1.1 architecture is componentized 
architecture, rather than a monolithic model with SCCS as the focal point.

Connectivity

LinkPlexer 1.1 provides conversion of ICM to X.25 and vice-versa allowing 
ICM-only applications to be used with existing CompuCall links.

Compatibility

LinkPlexer performs no protocol conversion. Applications conforming to the NIS 
Q218 CompuCALL/Meridian SCAI Interface Specification should work in a 
Linkplexer integrated environment.

Considerations & Limitations

• “Co-residency” ‚ next

• “Application Considerations” on page 24

• “Limitations” on page 25

Co-residency

The following table illustrates the co-residency support for LinkPlexer 1.2 on 
supported Windows operating systems.

Table 1   Co-Residency support for LinkPlexer 1.2

Symposium 
Agent 2.3

ICM TAPI Driver 
1.0

SCCS 3.0/SCCS 
4.0 PERI ICM 2.04

Windows NT 
Server 4.0

NO YES NO NO

Window 2000 
Server

NO NO NO NO
LinkPlexer 1.2 Installation and Configuration Guide
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Nortel Networks recommends that LinkPlexer 1.2 be installed on a separate server 
due to the following reasons:

• Reliability: with LinkPlexer 1.2 running on a separate server you can mak
changes to co-resident applications without affecting the status of their lin
the switch - this allows call centre activity to continue for other applications
the solution.

• Trouble Shooting: with LinkPlexer 1.2 running on a separate server, diagn
of issues would be limited to LinkPlexer and other applications conflicting
with the operations of LinkPlexer software would not have to be eliminate

Refer to “Startup Procedures for Nortel Networks Call Centre Equipment” on 
page 102, for pertinent startup information.

Application Considerations

Associated LinkPlexer 1.2 applications must cooperate in controlling commo
resources

• A ‘race’ condition will result if two applications attempt to change the state
the same device at the same time

• One application should control the device, others monitor events only

The applications must also be tolerant of receiving events related to resource
the application had not previously been associated with

• The impact of receiving these unexpected events cans only be determine
through testing the application in a LinkPlexer 1.2 environment

• Applications may still get events on devices they have disassociated

• Applications that disassociate resources may also affect other application
using those resources

• Applications will receive messages about resources that they are not 
monitoring, but other applications are monitoring.

Note: LinkPlexer 1.2 and LinkPlexer 1.1 co-residency is supported. 
However, some changes are necessary on LinkPlexer 1.2, so refer to
“Upgrade Procedure for LinkPlexer 1.1 to LinkPlexer 1.2” on page 99
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Limitations

LinkPlexer 1.2 has the following known limitations:

• X.25 Bandwidth

• EMPC interface limited to 19,200bps

• 512 Invoke IDs

• Invoke Ids are shared between applications

• Maximum of 512 invoke Ids in either direction

• Can run out of invoke IDs if switch latency is long

• Remote Alarm Monitoring is not supported

Engineering Guidelines

Nortel Networks does not recommend connecting more than 10 applications
LinkPlexer 1.2

For information on ICM Guidelines refer to http://triweb/ACD/icm/ICM.html
LinkPlexer 1.2 Installation and Configuration Guide
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Chapter 2
Pre- Installation Requirements & Procedures

This chapter contains the following sections:

• “System Requirements” ‚ next

• “Pre-installation procedures” on page 29

System Requirements

A LinkPlexer 1.1 system consists of a PC running MS Windows 2000 Server
operating system. The system is connected to a DMS/MSL-100 switch. Syste
requirements are described in the following sections:

• “Minimum server requirements” ‚ next

• “TCP/IP requirements” on page 28

• “X.25 requirements” on page 28

• “Other considerations” on page 29

Minimum server requirements

The following are the minimum server requirements:

• Pentium III - 933MHz

• MS Windows 2000 

Note: Refer to the Microsoft Hardware Compatibility list (http://
www.microsoft.com/hcl/default.asp) to ensure hardware and Operatin
System compatability. Refer to the hardware manufacturers web site 
ensure that the operating system is supported by them.
LinkPlexer 1.2 Installation and Configuration Guide
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• 128 MB RAM

• 18 GB storage

• Security dongle and keycode 

• Parallel port for dongle

• LinkPlexer supports two NIC cards. Two NIC cards are required if LinkPle
is co-resident with the ICM TAPI Driver.

• If X.25 (CompuCall) is being used, the following requirements are necess

• Two comm ports (only one is required for ICM)

• Eicon card

• Motorola V.3600 modem 

TCP/IP requirements

To connect to DMS/MSL-100 via TCP/IP the minimum requirements are:

• An EIU on the DMS/MSL-100 switch

• A 10Mb or 10/100 Mb ethernet card on the LinkPlexer 1.1 server

X.25 requirements

To connect via X.25 the minimum requirements are:

• An EMPC/MOC or IOM card on the DMS/MSL-100 switch

• An EICON C20 or C90 card on the LinkPlexer 1.1 server

• A pair of Motorola V.3600 stand alone modems

Note: LinkPlexer 1.2 will be supported on Windows 2000 Server 
operating system with the service pack number indicated in the readm
file.
Note: LinkPlexer 1.2 will be supported on Windows NT 4.0 Service 
Pack 6a so as to enable an upgrade without having to change operat
systems.
Note: LinkPlexer 1.1 is a software only product and Nortel Networks 
not responsible for replacing hardware components..



Chapter 2 Pre- Installation Requirements & Procedures 29

n.

 
 for 

 

n 

m 

he 

re 
,” 
Other considerations

The minimum switch requirements are:

• MSL-100: MSL-09 or later

• DMS-100: CCM10 (MMP10) or later

Administrator rights on the Local Server are required for LinkPlexer Installatio

Nortel Networks recommends the following:

• PC Anywhere V10.5 on systems which require remote administration.

• UPS backup power supply

Pre-installation procedures 

LinkPlexer 1.2 requires the following pre-installation procedures:

• TCP/IP must be configured and working prior to beginning the LinkPlexer
installation. See the system administrator’s manual for MS Windows 2000
information.

• MS Windows 2000 Server must be installed on the PC and installation of
LinkPlexer must be completed using the local administrator account.

• Nortel Networks requires that installation of pcAnywhere before installatio
of LinkPlexer 1.2.

• An ICM or CompuCall line to switch must be in place. See the Symposiu
Network Managers guide or the ICM guide for more information.

• LinkPlexer 1.2 supports the X.25 network protocol to communicate with t
DMS/MSL-100 switch. If using this protocol the hardware and network 
configuration must be completed before installing LinkPlexer 1.2. For mo
information See Chapter 6, “Installing and configuring the Eicon X.25 card
on page 81 and Chapter 4, “Configuring LinkPlexer 1.2,” on page 49.
LinkPlexer 1.2 Installation and Configuration Guide
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Chapter 3
Installing LinkPlexer 1.2

This chapter describes how to install and start LinkPlexer 1.2. It contains the 
following sections:

• “LinkPlexer 1.2 Checklist” ‚ next

• “Windows 2000 Service Pack Installation” on page 32

• “Dongle Installation” on page 33

• “LinkPlexer 1.2 Installation” on page 35

• “Starting the LinkPlexer 1.2 service” on page 42

• “Additional applications” on page 43

• “Un-installing LinkPlexer 1.2” on page 46

LinkPlexer 1.2 Checklist

The following items are supplied with LinkPlexer 1.2:

• LinkPlexer 1.2 CD, this includes the following folders and files:

• Documentation

— LinkPlexer 1.2 Installation & Configuration Guide.pdf

• ThirdParty

— DallasDongleDriver

— pcAnywhere_v10.5

— Windows2000ServicePack3

• Setup.exe and ancillary files

• iButton TMEX RTE dongle (with parallel port adapter) and associated 
keycodes
LinkPlexer 1.2 Installation and Configuration Guide
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Windows 2000 Service Pack Installation

LinkPlexer 1.2 is supported on a Windows 2000 server/Windows NT 4.0 
Operating System. However, the primary target operating system is Windows 
2000 Server. Windows NT 4.0 support requires service pack 6 to be installed on 
the system, refer to Chapter 3 Installing LinkPlexer 1.1, in the LinkPlexer 1.1 
Installation and Configuration Guide, for information on Windows NT 4.0 Service 
Pack installation. 

LinkPlexer 1.2 has no known specific Windows 2000 server service pack 
dependencies. The current service pack i.e. Service Pack 3 will be shipped on the 
cd for convenience. Any future dependency will be published in the Readme file 
also shipped with the product.

To check if Windows service pack 3 is present go to Start\Settings\Control 
Panel\Add/Remove Programs, on the LinkPlexer machine, and click to open it. 
Scroll through the list of programs and locate ‘Windows 2000 Service Pack 3
this is found, service pack 3 is present and no further actions are required. T
service pack version may also be found by typing ‘winver’ at the 
Start\Run...\Open: location.

If ‘Windows 2000 Service Pack 3’ is not present it must be installed.

1 Insert the LinkPlexer CD into the CD-ROM drive

2 In Windows Explorer, navigate to the 
E:\ThirdParty\Windows2000ServicePack3 folder (where E: is the CD-RO
drive).

3 Double click on executable W2Ksp3.exe

4 Follow the installation instructions - more installation information is availab
at http://www.microsoft.com/windows2000/downloads/servicepacks/sp3/
spdeploy.htm

At the time of printing, there were not any Windows 2000 server hot fixes 
required. Refer to http://www.microsoft.com for more information on relevant 
fixes.
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Dongle Installation

Nortel Networks provides an iButton TMEX RTE dongle (consists of an iButton 
and a Parallel Port Adapter), associated key codes, and Dallas Semiconductor 
1-Wire Driver (Win32) v3.20 with LinkPlexer 1.2. 

Figure 3   iButton TMEX RTE Dongle: Parallel Port Adapter (top) and iButton

To install the dongle and dongle drivers:

1 Attach the iButton TMEX RTE dongle to the parallel port of the LinkPlexer 
1.2 server.

2 Insert the LinkPlexer 1.2 CD into the CD-ROM drive.

3 In Windows Explorer, navigate to the E:\ThirdParty\DallasDongleDriver 
folder (where E: is the CD-ROM drive).

4 Double click the Install_1_Wire_Drivers_v320 icon.

Figure 3 shows the InstallShield dialog box.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 4   1-Wire Drivers InstallShield Self-extracting EXE 

5 Click Yes to continue.

Figure 5 shows the USB dialog box.

Figure 5   USB dialog box

6 If there is a 1-Wire USB device attached to the LinkPlexer 1.2 server PC, 
unplug it. Note that a 1-wire USB device is not required for LinkPlexer 1.2

7 Click OK.

The Software Licence Agreement is displayed.

8 Click Yes to continue the installation.

The Readme Information dialog box is displayed.

9 Click Next.

The Choose Destination Location dialog box is displayed.

10 Click Next to accept the default location.

The Select Program Folder dialog box is displayed.

11 Click Next.

Figure 6 shows the BOOT Option dialog box.
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Figure 6   1-Wire Drivers BOOT Option

12 Click OK.

The Setup Complete dialog box is displayed.

13 Click Finish.

14 Restart the LinkPlexer 1.2 server.

LinkPlexer 1.2 Installation

This section describes how to install the LinkPlexer 1.2 application from the CD. 
The supplied keycode is necessary to complete the installation.

To install LinkPlexer 1.2: 

1 Insert the LinkPlexer 1.2 CD into the CD-ROM drive.

2 In Windows Explorer, navigate to the CD-ROM drive folder 

3 Double click the Setup icon. If LinkPlexer 1.1 is installed on the same 
machine, a warning dialog box will appear, requesting the customer to refer to 
customer documentation. Refer to “Upgrade Procedure for LinkPlexer 1.1 to
LinkPlexer 1.2” on page 99 for more information

Figure 7 shows the InstallShield Wizard for LinkPlexer 1.2
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 7   LinkPlexer 1.2 Setup 

4 Click Next.

The License Agreement dialog box is displayed.

5 To accept the terms of the LinkPlexer 1.2 license agreement, click Yes.

Figure 8 shows the Customer Information dialog box.
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Figure 8   Customer Information

6 Type a user name in the User Name text box.

7 Type the relevant company name in the Company Name text box.

8 Click Next.

Figure 9 shows the Choose Destination Location dialog box.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 9   Choose Destination Location

9 To accept the default destination folder, click Next. 

10 Click Next.

Figure 10 shows the Select Program Folder dialog box.
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Figure 10   LinkPlexer 1.2 Setup Select Program Folder

11 To accept the default program folder, click Next. To select a new folder, type 
the folder name in the Program Folders text box. To select an existing folder 
highlight it in the Existing Folders list.

12 Click Next.

Figure 11 shows the Setup Complete dialog box.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 11   Setup Complete

13 To launch LinkPlexer 1.2 Keycode Tracker:

a Select the I would like to enter the LinkPlexer 1.2 Keycode Tracker check 
box. Note, this can be launched separately by clicking on the link in 
Start\Program Menu\Nortel LinkPlexer 1.2\Keycode Tracker

b Click Finish.

Figure 12 shows the keycode dialog box.



Chapter 3 Installing LinkPlexer 1.2 41
Figure 12   LinkPlexer KeycodeTracker

c Type the supplied keycode in the Keycode text boxes.

d Click Apply.

The LinkPlexer 1.2 KeycodeTracker dialog closes.

The Setup Complete dialog box is displayed.

e Deselect the I would like to enter the LinkPlexer 1.2 Keycode Tracker 
check box in the Setup Complete dialog box.

14 To display the readme file:

a Select the I would like to view the readme file check box and click Finish.

b Read and close the Readme file.

The Setup Complete dialog box is displayed.

c Deselect the I would like to view the readme file check box in the Setup 
Complete dialog box.

15 Click Finish.
LinkPlexer 1.2 Installation and Configuration Guide
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Starting the LinkPlexer 1.2 service

To start LinkPlexer 1.2:

1 From the Windows 2000 Start menu, select Settings, and click Control Panel.

2 Select Administrative Tools and the double-click on Services.

The Services window is displayed as in Figure 13.

Figure 13   Services Control Panel

3 Select Nortel LinkPlexer 1.2 in the scroll box.

4 Click the Start button. 

LinkPlexer starts. 

If LinkPlexer 1.2 does not start correctly see Chapter 7, “Maintenance & 
Troubleshooting LinkPlexer,” on page 87.

Note: LinkPlexer 1.2 must be configured prior to starting the service 
(refer to Chapter 4: Configuring LinkPlexer 1.2 for details)
Note: If LinkPlexer 1.1 is co-resident with LinkPlexer 1.2, then the 
LinkPlexer 1.1 service must be specified as Manual. Refer to Chapte
upgrading form LinkPlexer 1.1 to LinkPlexer 1.2 for details???????
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Additional applications

The LinkPlexer 1.2 installation includes 2 additional applications, these are 
discussed in the following sections:

• “LinkPlexer Tracker” on page 43

• “LinkPlexer Keycode Tracker” on page 44

LinkPlexer Tracker

The LinkPlexer Tracker application provides information about the LinkPlexe
1.2 build version and the MS Windows NT system. It detects and displays 
information on the MS Windows operating version, the build number and dat
the installation, and the version number and date of install of any PEP installa

To launch the Tracker application:

Figure 14 shows the Tracker application window.

From the Start menu, select Programs>Nortel LinkPlexer 1.2>Tracker
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 14   LinkPlexer Tracker application window

The LinkPlexer Tracker application window displays the following Components 
and Information:

• Windows: This refers to the operating system and service pack versions

• Tracker: indicates the current version of the LinkPlexer Tracker applicatio

• DMS Server File Stamp: refers to the version of the File Stamp

• Build Info: indicates the LinkPlexer 1.2 build.

The date for the Tracker, DMS Server File Stamp and Build Info components
refers to the date LinkPlexer 1.2 was installed.

LinkPlexer Keycode Tracker

The LinkPlexer Keycode Tracker application enables the entering of the dong
keycodes. It also displays the number of agents that can connect to the LinkP
1.2 server.
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The Keycode Tracker is also used to confirm dongle detection. If a dongle is 
detected the ‘Check Dongle’ box, on the Keycode Tracker window, displays 
‘Connected’ as in Figure 15. If the dongle is not detected the user will see ‘Not 
Connected’. If this occurs refer to Chapter 7, “Maintenance & Troubleshooting 
LinkPlexer,” on page 87. 

Alternatively, the dongle may be also be detected using iButton applications 
referred to at http://www.ibutton.com/software/tmex/index.html

To enter keycodes with LinkPlexer Keycode Tracker:

1 From the Start menu, select Programs>Nortel LinkPlexer 1.2>Keycode 
Tracker.

Figure 15 shows the default Keycode Tracker window.

Figure 15   LinkPlexer Keycode Tracker

2 Type the supplied 20-character keycode in the Keycode text boxes.

3 Click Apply.
LinkPlexer 1.2 Installation and Configuration Guide
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Un-installing LinkPlexer 1.2

To un-install LinkPlexer 1.2 using the Add/Remote Programs control panel:

1 Close all running applications and close all open windows on the desktop 
including Windows Explorer.

2 From the Start menu, select Settings>Control Panel. 

3 Open the Add/Remove Programs control panel. 

4 Select LinkPlexer 1.2 in the Install/Uninstall tab screen, and click OK.

LinkPlexer 1.2 is removed from the system

To uninstall LinkPlexer 1.2 using the LinkPlexer Setup program:

1 Close all running applications and close all open windows on the desktop.

2 Insert the LinkPlexer 1.2 CD into the CD-ROM drive.

3 Navigate to the CD-ROM drive, via the My Computer icon on the desktop.

4 Double click the Setup icon.

Figure 16 shows the Modify, repair, or remove the program dialog box.
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Figure 16   Modify, repair, or remove the program

5 Select the Remove radio button, and click Next.

Figure 17 shows the Confirm File Deletion dialog box.

Figure 17   Confirm File Deletion

6 Click OK.

Figure 18 shows the Maintenance Complete dialog box.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 18   Maintenance Complete

7 Click Finish.

The LinkPlexer 1.2 application is removed from the system.
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Chapter 4
Configuring LinkPlexer 1.2

This chapter contains information on the following topics:

• “LinkPlexer 1.2 Configuration” ‚ next

• “X.25 configuration” on page 52

• “TCP/IP Connections” on page 56

• “Configuring the DMS/MSL-100 switch” on page 57

• “Configuring SCCS to use LinkPlexer 1.2” on page 57

• “Configuring the ICM TAPI Driver to use LinkPlexer 1.2” on page 60

• “Configuring Periphonics VPS/IS (Peri-ICM) to use LinkPlexer” on page 6

LinkPlexer 1.2 Configuration

LinkPlexer 1.2 is configured using a single configuration file called 
LPConfig.ini which exists in the LinkPlexer 1.2 install directory, by default 
C:\Program Files\Nortel\LinkPlexer 1.2. This single configuration file replaces 
DMSGlobal.ini and DMSLocal.ini required in LinkPlexer 1.1

The Configuration file is read when LinkPlexer 1.2 is started. All entries are r
at startup however LinkPlexer 1.2 will check for updates to certain fields in th
configuration file every 10 seconds. Configuration items are grouped by func
‘dynamic OR static’ and ‘mandatory OR optional’.

Dynamic Configuration Items: These items will be read shortly (less than 10 
seconds) after the configuration file is modified. They can be changed withou
stopping the Linkplexer 1.2 service.
LinkPlexer 1.2 Installation and Configuration Guide
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Static Configuration Items: These items ware only read at LinkPlexer service 
startup. To change one of these items the LinkPlexer service must be stopped and 
restarted after modifying the configuration file.

Mandatory Configuration Items: These configuration items must be present in 
the configuration file and must be valid (within specified ranges). If they are not 
present or are set incorrectly, the LinkPlexer service will NOT start, A fatal error 
indicating the reason will be logged.

Optional Configuration Items: These configuration items are NOT mandatory. 
If they are not present in the configuration file or their setting are not within the 
specified ranges the specified default settings will be used.

New configuration items have been added to manage logging (refer to “Log files” 
on page 89) and appear under the section [Logging-Dynamic]. Information abo
the agent is contained in [Agent] and the section [Agent-Dynamic] contains th
dynamic entries pertaining to client connection management.The dv-Appl-Lo
is the message that LinkPlexer 1.2 will send to the switch on service startup.
dc-Appl Logon message includes the parameters in [Switch-Logon] that mus
configured on LinkPlexer 1.2.

Table 2 describes the sections and configuration items in the LPConfig.ini file 
Figure 19 on page 55shows the default content for the LPConfig.ini file.

Table 2   LPConfig.ini Section and Parameter Descriptions

Config. Item Description
Range/
Settings Default Mandatory Type

[Logging-Dynamic]

MaxLogFileSize- 
Megs

Specifies the maximum size in 
megabytes that the current logfile 
LP_Curr.log will reach before 
being moved to LP_Prev.log. After 
being moved LP_Curr.log will be 
recreated empty and logging to 
this file continues

1-50 1 NO Dynamic

IcmMessageLogging Determines whether or not hex 
dumps of the ICM messages to and 
from the switch will be logged to 
the file ‘LP_SndRcvCurr.log’.

ON or 
OFF

OFF NO Dynamic
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IcmMessageMaxLog- 
FileSizeMegs

Specifies the maximum size in 
megabytes that the current 
Linkplexer ICM message logfile 
‘LP_SndRcvCurr.log’ will reach 
before being moved to 
‘LP_SndRcvPrev.log’. After being 
moved ‘LP_SndRcvCurr.log’ will 
be recreated empty and logging to 
this file continues.

1 - 50 1 NO Dynamic

[Agent]

AgentListenerPort Specifies the IP Port that 
LinkPlexer 1.2 will listen on for 
connections form LinkPlexer 1.2 
agents.clients (e.g. SCCS, TAPI 
etc.)

1 - 
65535

YES Static

[Agent-Dynamic]

AgentContinuityTest On receipt of a continuity message 
from the switch, this configuration 
item is read and the appropriate 
action is taken depending on 
whether it is set or not (refer to 
“Application-level connectivity 
checking” on page 21 for more 
information)

ON or 
OFF

ON NO Dynamic 
(item is 
read 
everytime 
a message 
is 
received 
form the 
switch)

AgentPingTest If Agent pinging is enabled all 
servers/machines on which active 
LinkPlexer 1.2 agents/clients 
(SCCS, TAPI etc.) are pinged at 
the configured time interval. Any 
agent machines that don’t’ respond 
to the ping in a timely fashion 
have their connections to 
LinkPlexer disconnected and the 
agent license becomes available. 
Refer to “ICMP connectivity 
checking” on page 20 for more 
details.

ON or 
OFF

OFF NO Dynamic

Table 2   LPConfig.ini Section and Parameter Descriptions

Config. Item Description
Range/
Settings Default Mandatory Type
LinkPlexer 1.2 Installation and Configuration Guide
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AgentPingInterval- 
Secs

This configuration item is only 
valid/read if ‘AgentPingTest’ is 
enabled (ON). It specifies the 
interval in seconds at which ping 
requests are sent to servers/
machines on which active Agents/
clients reside.

10 - 
86400 
(10 secs 
to 1 day)

60 NO Dynamic

[Switch]

SwitchLinkType Specifies the type of Link that 
LinkPlexer will attempt to use 
when communicating with the 
switch

IP or 
X25

IP NO Static

SwitchAddress Specifies the address (IP or X25) 
of the switch that LinkPlexer is to 
communicate with.

Valid IP 
or X25 
address

YES Static

SwitchPort Specifies the Port (IP or X25) on 
the switch that LinkPlexer will 
attempt to connect to.

1 - 
65535

YES Static

SwitchReplyTimeout- 
MilliSecs

Specifies the time in milli-seconds 
that LinkPlexer will wait for a 
response to a request sent to the 
switch. Responses received from 
the switch after this timeout period 
will be discarded.

250 - 
300000 
(250ms 
to 5 
Mins)

10000 
(10 Secs)

NO Static

SwitchContinuityTest If switch Continuity testing is 
enabled (ON), LinkPlexer will 
send a dv-Appl-Continuity-Test to 
the switch at the configured time 
interval 
(SwitchContinuityIntervalSecs). If 
the switch does not reply to the 
message within 
‘SwitchReplyTimeoutMilliSecs’ 
the link to the switch is dropped.

ON or 
OFF

OFF NO Static

SwitchContinuity- 
IntervalSecs

This configuration item is only 
valid/read if ‘SwitchContinuity 
Test’ is enabled (ON). It specifies 
the interval in seconds at which 

60 - 
86400 (1 
Min to 1 
Day)

600 NO Static

Table 2   LPConfig.ini Section and Parameter Descriptions

Config. Item Description
Range/
Settings Default Mandatory Type



Chapter 4 Configuring LinkPlexer 1.2 53
[Switch-Login]

NetworkNodeID Specifies the switch with which 
the LinkPlexer wishes to 
communicate. This is the switch 
which LinkPlexer connects to via 
the ICM/CompuCALL link and is 
defined by the operating company. 
(Switch: defined in NETNODEID 
of the table SCAIGRP)

0 - 
32767

YES Static

ServiceID Identifies a service profile for a 
session. An operating company 
can define functions and 
parameters in service profiles on 
the switch. Also an operating 
company can assign a customer up 
to eight service IDs (Switch: 
Defined in 
PROKEY.LINKSET.SRVCID of 
table SCAIPROF)

0 - 255 YES Static

ServiceVersion Specifies the application level 
signaling version used by 
LinkPlexer

0 - 
65535

YES Static

BusinessGroupID Identifies the customer to whom 
the LinkPlexer application 
belongs. This is defined by the 
operating company. (Switch: 
Defined in BGID in table 
BGDATA and ECM option in 
table CUSTNTWK)

1 - 
4194304

YES Static

ApplicationID Identifies the specific LinkPlexer 
application indicting the logon 
request

1 - 
32767

YES Static

Table 2   LPConfig.ini Section and Parameter Descriptions

Config. Item Description
Range/
Settings Default Mandatory Type
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Password This is used for security purposes 
and corresponds to a specific 
‘BusinessGroupID’. One 
password datafilled for the 
customer is applicable to all eight 
service IDs. (Switch: Defined in 
PASSWORD in table SCAIGRP)

Variable 
length 
IA5- 
String (1 
to a Max. 
of 8 
Char’s)

YES Static

TcpLinkSetName TCP connections between the 
LinkPlexer and the switch use 
TcpLinksetName to identify which 
linkset is sent to dv-Appl-Logon. 
For X.25 connections, 
TcpLinkSetName is not applicable 
and is not checked by the switch. 
If TcpLinkSetName is set for X.25 
connections, the parameter is 
simply ignored by the switch. 
(Switch: Defined in LINKSET in 
table SCAICOMS)

Variable 
length 
IA5- 
String (1 
to a Max. 
of 8 
Char’s)

NO Static

Table 2   LPConfig.ini Section and Parameter Descriptions

Config. Item Description
Range/
Settings Default Mandatory Type
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Figure 19   Default Content of LPConfig.ini

Note: There has been changes made to the configuration files and 
parameters between the LinkPlexer 1.1 release and LinkPlexer 1.2 
release. For a list of the changes refer to “Appendix D: LinkPlexer 
Configuration Changes” on page 122
LinkPlexer 1.2 Installation and Configuration Guide
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X.25 configuration

Chapter 6, “Installing and configuring the Eicon X.25 card,” on page 81 describes 
how to install and configure the Eicon X.25 card.

To specify X.25 as the protocol that LinkPlexer 1.2 uses to communicate with
DMS/MSL-100 switch:

1 Ensure that the DMS/MSL-100 datafill specifies the correct setup informat
for the X.25 link. 

For more information, see “Configuring the DMS/MSL-100 switch” on 
page 57.

2 Configure the parameters in the [Switch] section of the LPConfig.ini file:

a Set the SwitchLinkType parameter to DMSX25.

b Ensure that the SwitchAddress parameter contains the necessary X.2
information to connect to the DMS/MSL-100 i.e. the Calling DNA (in 
table SCAICOMS), the Called DNA (in SVCDNA in table MPCLINK), 
and the port number.

This information is specified in LPConfig.ini as follows:

SwitchAddress=[Calling DNA],[Called DNA]:[port number]

For example:

SwitchAddress=111111111,111222333:2500

3 Use the error log files (refer to “Log files” on page 89) to verify that the X.25 
connection is established correctly when LinkPlexer 1.2 is started.

TCP/IP Connections

To specify TCP/IP as the protocol that LinkPlexer 1.2 uses to communicate w
the DMS/MSL-100 switch:

1 Ensure that the DMS/MSL-100 switch datafill specifies the correct setup 
information for the TCP/IP link. 

2 Configure parameters in the [Switch-n] section of the LPConfig.ini file:
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a Set the SwitchLinkType parameter to DMS.

b Ensure that the SwitchAddress parameter contains the necessary TCP/IP 
information to connect to the DMS/MSL-100 i.e. the IP address and port 
of the DMS/MSL-100 which this server connects to (defined in the 
CMIPADDR parameter in the IPNETWRK table).

This information is specified in LPConfig.ini as follows:

SwitchAddress= IP Address:Port

For example:

SwitchAddress=123.4.5.6:2500

3 Use the error log files to verify that the TCP/IP connection is established 
correctly when LinkPlexer 1.2 is started.

Configuring the DMS/MSL-100 switch

To configure the DMS/MSL-100 switch the ACD groups information must be 
specified. The required information is specified in the DMS/MSL-100 Switch 
tables by the administrator of the DMS/MSL-100 switch. Definitions, and 
examples, of these are found in Appendix B “Appendix B: DMS/MSL100 Table 
Definitions & Examples” on page 116.

Configuring SCCS to use LinkPlexer 1.2

To configure the SCCS to use the LinkPlexer 1.2 application:

1 From the SMI window, choose System Administration>System 
Configuration>Server Settings.

The Feature Report dialog box is displayed. 

2 Select the Switch Information tab. Figure 20 shows the Switch Information 
tab dialog box.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 20   Feature Report Switch Information dialog box

3 In the Switch Name text box, type the name of the switch.

4 In the Switch IP Address text box, type the IP address of the LinkPlexer 1.2 
server. 

SCCS assumes the port number is 2500.

5 In the Switch Sub Type text box, select DMS-100 from the pull-down menu.

6 Click on the Edit DMS Switch Parameters button.

The DMS Parameter dialog box is displayed. Figure 21 shows the DMS 
Parameter dialog box.
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Figure 21   DMS/MSL-100 Parameter dialog box

7 Set the parameters in the DMS/MSL-100 Parameter dialog box to match the 
settings in the LPConfig.ini file and the DSM/MSL-100 Switch tables. 

Table 3 shows the location of the parameter values.

Table 3   DMS/MSL-100 Parameter value locations

Parameter LPConfig.ini file Parameter DMS/MSL Switch table and parameter

Network Node ID NetworkNodeID SCAIGRP table, NETNODID parameter

Service ID ServiceID SCAIPROF table, PROFKEY.LINKSET.SRVCID 
parameter

Application ID ApplicationID

Service Version ServiceVersion Provided by the DMS/MSL-100 Switch 
administrator

Business Group ID BusinessGroupID BGDATA table, BGID parameter
CUSTNTWK table, ECM parameter

LinkSet Name TcpLinkSetName SCAICOMS table, LINKSET parameter

DMS Password Password SCAIGRP table, PASSWORD parameter
LinkPlexer 1.2 Installation and Configuration Guide
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8 Click OK to close the DMS Parameter dialog box.

9 Click OK to close the Feature Report dialog box.

For more information, including information about the relationships between 
fields and tuples (parameters and values) in the DMS/MSL-100 switch tables, see 
the Nortel Networks Symposium Call Center Server and DMS Switch Guide, part 
number 911815.

Configuring the ICM TAPI Driver to use LinkPlexer 1.2

To configure the ICM TAPI driver (on the ICM TAPI server) to use the 
LinkPlexer 1.2 application:

1 Open the Add Customer Properties dialog box.

Figure 22 shows the Add Customer Dialog box.

Caution: Where SCCS and TAPI associate the same CDN, that is under 
the control of SCCS, it is posisble for TAPI to cause SCCS to stop routing 
calls. Therefore, ensure that there is TAPI and SCCS CDN partitioning 
i.e. ensure that TAPI does not share the same CDNs as SCCS.
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Figure 22   Add Customer Properties dialog box

2 Set the parameters in the Add Customer Properties dialog box to match the 
settings in the LPConfig.ini file, and the DMS/MSL-100 Switch tables.
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Table 4 shows the location of the parameter values.

3 In the Link Sets section of the Add Customer Properties dialog box, click 
Add.

The Add Link Sets dialog box is displayed as in.

Figure 23   Link Set Dialog box

4 Type the Link Set name for this link set. 

The link set name is defined by the LinksetName parameter in the 
LPConfig.ini file, and by the LINKSET parameter in the DMS/MSL-100 
switch SCAICOMS table.

5 In the Name text box, type the name of this link.

Table 4   DMS/MSL-100 Parameter locations

Parameter
LPConfig.ini file and 
parameter DMS/MSL Switch table and parameter

Network NodeID NetworkNodeID SCAIGRP table, NETNODID parameter

Service ID ServiceID SCAIPROF table, PROFKEY.LINKSET.SRVCID 
parameter

Application ID ApplicationID

ServiceVersion 
ID

ServiceVersion Provided by the DMS/MSL-100 Switch 
administrator

Business Group 
ID

BusinessGroupID BGDATA table, BGID parameter
CUSTNTWK table, ECM parameter

LinkSet Name TcpLinkSetName SCAICOMS table, LINKSET parameter

Password Password SCAIGRP table, PASSWORD parameter
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and 
6 In the Type pull-down menu, select TCP/IP.

Select TCP/IP, even if LinkPlexer 1.2 uses an X.25 connection to the switch.

7 In the IP Address text box, type the IP address of the LinkPlexer 1.2 server.

8 In the Port text box, type the port number, 2500.

9 To close the Add Customer Properties dialog box, click OK.

For more information on configuring the ICM TAPI drivers, refer to ICM TAPI 
Network Managers Guide (part number PO881940).

Configuring Periphonics VPS/IS (Peri-ICM) to use 
LinkPlexer

To configure a Peri-ICM package on a Link Server for use with LinkPlexer 1.2 the 
PBX Link Connection must be configured.

1 Locate the hosts file in C:\WINNT\system32\drivers\etc\hosts on the 
Peri-ICM server.

2 The hosts file must be edited by adding the PBX Link IP address using the 
PBX Configuration Edits, for example: 192.84.161.227 pbxlink

3 For DMS100 connection with PERI-ICM, SCCS and/or TAPI server, add the 
LinkPlexer’s (CLAN) IP address as pbxlink in the hosts file.

For more information on configuring the Peri-ICM package, refer to the MPS 
VPS/is interface to M1/DMS100 (peri-IPML v2.0, Peri-ICM v2.0) document 
(part number P0988599).
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Chapter 5
Installing and configuring pcAnywhere

One copy of pcAnywhere version 10.5 is provided for the LinkPlexer 1.2 server. 
The installer application is located in the ThirdParty folder on the LinkPlexer 1.2 
CD. 

In the case of co-residency with TAPI, a modem is not supported and the TAPI 
guidelines, found in the ICM TAPI Network Managers Guide (part number 
PO881940), must be followed. Chapter 5 Additional Tools, of the ICM TAPI 
Network Managers Guide contains a section on pcAnywhere configuration.

This chapter contains the following sections:

• “Installing pcAnywhere version 10.5” ‚ next

• “Configuring pcAnywhere” on page 66

• “Uninstalling pcAnywhere 10.5” on page 78

Installing pcAnywhere version 10.5

To install pcAnywhere version 10.5

1 Log on to the server as Administrator.

2 Shut down all running applications

3 Insert the LinkPlexer 1.2 CD into the CD-ROM drive.

4 In Windows Explorer, navigate to the E:\ThirdParty\pcAnywhere_v10.5\D
1 folder (where E: is the CD-ROM drive).

5 Double click the Setup.exe file.

The Symantec installation wizard window is displayed.

6 Click Next.
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The License agreement is displayed.

7 Accept the terms of the license agreement, then click Next.

The Customer Information window is displayed.

8 Type the User Name and Organization name, then click Next.

The Setup Type window is displayed.

9 Select Typical, then click Next

The Ready to Install window is displayed

10 Click Install. Follow the instructions in the wizard for the type of installation 
selected.

11 When the installation is complete, restart your computer

Configuring pcAnywhere

Administrator privileges on the server PC are necessary to configure 
pcAnywhere.

This section contains the following topics:

• “Password recommendations” ‚ next

• “Starting pcAnywhere for the first time” on page 67

• “Changing User access rights” on page 67

• “Setting the video mode” on page 68

• “Configuring pcAnywhere host PC network properties” on page 68

• “Changing pcAnywhere caller passwords” on page 77

Password recommendations

Plan the passwords required for the user accounts. Use the same passwords
pcAnywhere caller passwords that are planned for use with the Windows NT
accounts. This simplifies the remote logon process.
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To maintain remote access security, change the passwords for the caller accounts 
regularly. Continue to match the pcAnywhere caller passwords to the Windows 
NT user account passwords.

For more information on resetting caller account passwords, See “Changing 
pcAnywhere caller passwords” on page 77.

Starting pcAnywhere for the first time

To start pcAnywhere for the first time:

1 Log on to MS Windows 2000 as Administrator.

2 From the Windows Start menu choose Programs>Symantec pcAnywhere

3 If asked to register pcAnywhere, select Skip, and then choose Yes when a
to confirm.

The Smart Setup Wizard window is displayed.

The system prompts for the modem device.

4 Choose the entry that matches the modem in use, then click Next. Note, 
driver supplied by the modem vendor is not listed, then it must be installe

The system prompts for network device selection.

5 Ensure that only TCP/IP is selected, then click Next.

The system prompts for port selection.

6 Select COM1, then click Next.

7 Click Finish.

The pcAnywhere main window is displayed.

Changing User access rights

If during pcAnywhere configuration, a message is received indicating that the
user does not have the rights to modify a setting or create a new caller, the u
must change the Windows NT User access rights for pcAnywhere files.

To change the Windows NT User access rights for pcAnywhere files:
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1 Ensure that pcAnywhere is not running.

2 Navigate to %Systemroot%Profiles\All Users\Application Data\Symantec.

3 Select the pcAnywhere directory.

4 Right-click the directory icon, choose Properties, and then click the Security 
tab.

5 Click on Permissions and, for Administrators, select Type of Access: Full 
Control.

6 Click OK to save changes.

7 Click OK to close the Properties window.

Setting the video mode

To set the pcAnywhere video mode:

1 Open pcAnywhere.

2 Choose Tools>Application Options.

3 Click the Host Operation tab.

4 For Video mode, ensure that the option selected in the drop-down list is 
Default.

5 Click Apply to save the changes.

6 Click OK to exit.

Configuring pcAnywhere host PC network properties

To configure pcAnywhere network properties on a host PC:

1 Log on to Windows 2000 as Administrator.

2 From the Windows Start menu, choose Programs>Symantec pcAnywhere.

pcAnywhere starts.

3 Select New Host.

4 The New Host Properties window is displayed.
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5 Select a tab window to view the network property options. For information on 
configuring tab window properties refer to the following sections:

• “Configuring connection information” ‚ next

• “Configuring settings” on page 70

• “Configuring callers” on page 71

• “Setting security options” on page 74

• “Setting Conference options” on page 75

• “Password controlling network configuration” on page 76.

Configuring connection information

To configure network connection settings:

1 Click the Connection Info tab.

Figure 24 shows the New Host Properties Connection Info tab window.
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Figure 24   NEw Host Properties Connection Info tab window

2 Ensure that only TCP/IP is checked.

3 Click Apply to save changes.

Configuring settings

To configure the network settings:

1 Click the Settings tab.

Figure 25 displays the New Host Properties Settings tab window.
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Figure 25   New Host Properties Settings tab window

2 Ensure that the settings match those shown in Figure 25.

3 Click Apply to save changes.

Configuring callers

To allow remote users to connect to the LinkPlexer 1.2 server PC caller accounts 
must be configured. If creating an account to allow remote administration of 
LinkPlexer 1.2, then at least one account will full administrator access must be 
created.
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This section describes how to create and configure two remote users, NGenDist 
and NGenDesign. The suggested passwords and login names are for example 
purposes only. Passwords and login names should be configured to match the 
Windows NT user accounts on the LinkPlexer server PC.

To configure caller accounts:

1 Click the Callers tab.

Figure 26 shows the New Host Properties Callers tab window.

Figure 26   New Host Properties Callers tab window

2 Select the Use pcAnywhere authentication with pcAnywhere privileges radio 
button.
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3 Place the mouse in the blank area and right-click to display the properties 
dialog box.

4 Select New to add a new caller.

The New Caller Properties window is displayed.

5 Type the Login name NGenDist and the password ntdist.

6 In the Confirm Password box, retype the password.

7 Click OK to save the changes.

The Callers tab window is displayed.

8 Right-click the NewCaller icon, select rename, and type NGenDist.

9 Repeat steps 3 to 8 to create the NGenDesign caller, using the password 
Nortel.

10 Right-click the NGenDesign caller icon, and then select Properties.

11 Click the Privileges tab.

Figure 27 shows the NGenDesign Properties Privileges tab window.
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Figure 27   NGenDist Properties Privileges tab window

12 Select the Superuser radio button.

13 Click Apply to save the changes.

14 Repeat steps 10 to 13 for the NGenDist caller.

Setting security options

To configure security options:

1 Click the Security Options tab.

Figure 28 shows the New Host Properties Security Options tab window.
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Figure 28   New Host Properties Security Options tab window

2 Ensure that the settings match those shown in Figure 28.

3 Click Apply to save changes.

Setting Conference options

To configure conference options:

1 Click the Conference tab.

Figure 29 shows the NETWORK Properties Conference tab window.
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Figure 29   New Host Properties Conference tab window

2 Ensure that Enable conferencing and Obtain IP address automatically are 
selected.

3 Click Apply to save changes.

Password controlling network configuration

To control access to network configuration options:

1 Click the Protect Item tab.

2 To assign a password to control who can modify the Network icon settings, 
enter a password on this screen.
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3 Click Apply to save changes.

Changing pcAnywhere caller passwords

During the installation and configuration of pcAnywhere, login passwords for the 
NGenDist and NGenDesign callers are specified. To maintain system security, 
change these passwords periodically. 

To simplify the remote login process, the same passwords for the pcAnywhere 
NGenDist and NGenDesign caller passwords should be used as those planned for 
use with the MS Windows NT NGenDist and NGenDesign accounts. Change the 
pcAnywhere caller passwords and the Windows NT user account passwords for 
NGenDist and NGenDesign at the same time.

For more information, See “Password recommendations” on page 66.

To change passwords:

1 Log on to Windows 2000 as Administrator.

2 From the Windows Start menu, choose Programs>Symantec pcAnywher

pcAnywhere starts

3 From the File menu, choose Properties.

The Host Properties property sheet appears.

4 Click the Callers tab.

5 Click Specify individual caller privileges.

6 Right-click the NGenDist icon and then select Properties.

7 Click the Identification tab.

8 In the Password text box, type a new NGenDist password.

9 In the Confirm Password text box, type the NGenDist password again.

Caution: If the option Required is selected in order to modify propertie
the password must be entered each time a setting is changed. The 
password should be recorded and a copy of it kept in a safe place. If 
password is forgotten, non of the settings can be changed.
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10 Click Apply.

11 Click OK.

12 Right-click the NGenDesign icon. Then select Properties.

13 Repeat steps 8 to 13 to assign a new password to NGenDesign.

14 Click OK to return to the main pcAnywhere window.

15 Exit pcAnywhere.

Once the server connection profile has been created, the profile must be 
configured. The connection properties window is displayed.

Uninstalling pcAnywhere 10.5

Before uninstalling pcAnywhere, ensure there is no pcAnywhere Waiting icon on 
the desktop. If the icon is on the desktop, right-click it and select Cancel Host.

1 From the Windows Start menu, choose Settings>Control Panel.

2 Double-click the Add/Remove Programs control panel.

3 Select Symantec pcAnywhere and click Add/Remove.

The Symantec pcAnywhere Setup window is displayed.

4 Click Next.

The Program Maintenance options window appears.

5 Select Remove and click Next.

The Remove the Program window appears.

6 Click Remove.

7 When the process completes, click Finish.

8 From the Windows Start menu, choose Shutdown.

The Shut Down Windows dialog box appears.

9 Select Restart, and then click Yes.

The server shuts down and then begins starting up. If the system does not 
restart, it must be restarted manually.
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Note: For more information on Installing and Configuring pcAnywhere 
10.5 please consult http://www.symantec.com/techsupp/enterprise/
products/pca/pca_105/manuals.html
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Chapter 6
Installing and configuring the Eicon X.25 card

This chapter contains the following sections:

• “Supported configurations for X.25”‚ next

• “Installing the Eicon X.25 card” on page 82

Supported configurations for X.25

There are 2 supported configurations for X.25: 

• A direct connection using a modem eliminator (or null modem) for distanc
of 50 feet or less.

• A normal modem connection for distances greater than 50 feet. 

Figure 30 shows the X.25 connection configuration to LinkPlexer 1.2.
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Figure 30   Switch Connections

Installing the Eicon X.25 card

To install and configure the Eicon X.25 card: 

1 Insert the Eicon Card (C20 or C90) into the slot in the computer. It is not 
necessary to change any settings on the card. Refer to the following website 
for detailed installation instructions http://www.eicon.com/worldwide/
support/docs.htm?en_prod=Eiconcard_C20

2 Connect the Eicon Card and the modem using the V24 cable (db25 to db25).

3 Install the Driver:

Note: The supported modem is the Motorola V.3600 modem. For further 
information on specifications and configuration refer to the V.3600 
Modem User guide, a copy of which is located at http://
www.arcelect.com/V3600_Modem_manual.htm. http://
www.motorola.com may also be used for reference.

X.25 Connection to LinkPlexer

Nortel
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Cable

Motorola 
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Modem

Motorola 
V3600

Modem

EMPC or
IOM Card
In DMS

DMS-100

Telco 
Line or 
Direct 
Cable

Eicon C20 Card
in Linkplexer

Eicon 
300-007

V.24 DCE 
Cable

LinkPlexer
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a The driver for Windows NT 4.0 (c4wntv4r2c.exe) is available from the 
following website: http://www.eicon.com/cnnt/wanic/downld.htm

b Choose Add in the Network Adapter

c Choose Eicon Wan Adapters and select the location of the downloaded 
executable.

4 The Eicon card may be configured with the default values, except in the 
HDLC\Advanced tab which must use the values as in Figure 31. Appendix 
A on page 107 includes screenshots of the Eicon Configuration 
windows with appropriate values for LinkPlexer 1.2

Note: The ‘Check Point T1’ Timer in this dialog box must be changed
5000mSec. The default timer in the DMS/MSL-100 is 5000ms and th
Eicon default is 2900. Hence there will be a conflict if the timer is not 
changed to 5000mSec.
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Figure 31   Eicon Configuration HDLC:Advanced

5 Choose Yes to install OEM Option

6 Add the Eicon Performance Counter

7 Restart the computer

Figure 32 shows an example of the TAPI Server parameters and DMS-100 
Datafill values for X.25 connections.
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Figure 32   Example TAPI Server parameters & DMS-100 Datafill 

TAPI Server parameters and DMS-100 Datafill for 
X.25 Connection
LinkPlexer 1.2 Installation and Configuration Guide
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Chapter 7
Maintenance & Troubleshooting LinkPlexer

This section contains information on maintenance and troubleshooting common 
problems with LinkPlexer 1.2. It contains the following topics:

• “Common problems” on page 87

• “Frequently Asked Questions” on page 88

• “Log files” on page 89

• “LinkPlexer 1.2 Procedures” on page 93

Common problems

Table 5 describes the solutions to some of the problems that can occur when
running LinkPlexer 1.2.

Table 5   Common problems

Problem Solution

LinkPlexer not running Ensure that the LinkPlexer software has been installed, configured, and 
is running. Ensure that the dongle is connected and flagged as 
connected in the Keycode Tracker application. To check if LinkPlexer is 
running, access the drive where LinkPlexer is installed, and check the 
LP_Curr.log. If LinkPlexer did not start correctly, this log file should 
contain a startup error such as “invalid IP address” or “X.25 error”. A 
pop-up message may appear when attempting to start LinkPlexer, 
indicating a problem. If there has been a fatal error, this will be 
indicated by LP_Fatal_Error.log

DMS/MSL-100 is down... network 
problems 

Ensure that all of the machines involved are up and communicating 
properly (usually pinging one machine from another is sufficient)

Invalid DNs to be monitored Ensure that the ACD groups have been properly configured on the 
switch, and that the LPConfig.ini file matches that configuration
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Frequently Asked Questions

Table 6 shows the answers to some frequently asked questions about LinkPlexer 
1.2 installation and configuration. 

Call Info or Transfer fails (on client 
applications)

Ensure that the SwitchReplyTimeoutMilliSecs value is set to something 
reasonable (generally 5000 or more). Smaller values may cause client 
requests to time out without giving the switch time to complete a 
requested action.

No response to AgentContinuity 
Message

The switch expects a positive acknowledgement (RETURN-RESULT) 
from the Session Manager within 10 seconds. If the Session Manager 
doesn’t respond the Session Manager connection, the DMS/MSL-100 
connection and connections to all active agents are disconnected. Any 
agent that does not respond to the message in a timely fashion (5 
seconds) will be disconnected, and that agent license becomes 
available, but the Session Manager connection, the DMS/MSL-100 
connection and all the other agents remain connected.

Table 6   Frequently asked questions

Question Answer

How do I interpret LCD and LED 
fault indicators on the Motorola 
V.3600 modem? 

Motorola modems have six LEDs on the front and a display panel. 
When LinkPlexer is running correctly, the first four LEDs are lit and the 
last two blink. The display shows the words ON-LINE. Any other 
combination indicates that the modem is not working.

How do I install and migrate from 
one server to another? 

 LinkPlexer can not migrate from one server to another. However, if the 
LPConfig.ini file is backed up, found in the C:\Program 
Files\Nortel\Linkplexer folder, then LinkPlexer can be installed on a new 
server. Replace the LPConfig.ini file with the old one without 
re-configuration.   

How do I identify the latest version 
number or review fixes for 
LinkPlexer 1.2?

To identify the latest software version number, go to http://
sulaco.europe.nortel.com:8080/mpl/core_mm_view.cfm and under 
each build folder there is a list of pertinent PEPs. The applied software 
versions are available in the Tracker application. Ensure that this 
information is communicated with problem reports.

How do I use the front panel on a 
line driver to set the configuration?

See Chapter 4 of the Motorola V.3600 Series Modem User’s Guide, 
Part # T0097,C for information.

Table 5   Common problems (continued)

Problem Solution
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Log files

Log files record significant events and errors for the user. LinkPlexer 1.2 log files 
are created in a separate folder called Log under the LinkPlexer 1.2 installation 
folder (by default this is C:\Program Files\Nortel\LinkPlexer 1.2). The logging 
mechanism amalgamates all logging into a single file called LP_Curr.log in 
the Log directory.

Log files size will be dynamically configurable using the configuration file entry 
MaxLogFileSizeMegs. When the log file size reaches the limit then a backup 
copy of the log file called LP_Prev.log is created an stored in a folder called 
OldLogs off the Log folder. The current log file will be reinitialised and 
logging to this file continues.

What if the hard disc fails? How is 
the system recovered?

Setting up the new machine. Install LinkPlexer 1.2 from the CD-ROM. 
Replace the LPConfig.ini file with a backup copy of the original file. 
Refer to “Back-up of LinkPlexer 1.2 and Restoration to a New Server” 
on page 98

Does upgrading LinkPlexer require 
an outage? 

Yes.

What is the sequence of CTI 
servers?

The recommended boot sequence is:
1. LinkPlexer 1.2 server
2. SCCS 

3. TAPI. 
However, if Linkplexer is restarted, the switch link and all associations 
are dropped as well as the connections to SCCS and TAPI. Both SCCS 
and TAPI go into a link restart phase trying to reconnect to the ‘switch’. 
When Linkplexer comes up, it establishes the connection to the switch 
and allows SCCS and TAPI to reconnect to it. SCCS and TAPI then 
reassociate (reacquire) the lines and continue normally. 
If the connection between the switch and Linkplexer is lost and 
Linkplexer continues to run, it will drop the connection to SCCS/TAPI, 
forcing them into the link restart phase. Any server should be able to be 
restarted without impacting the others.

If there is a problem with the Eicon 
X.25 card, how are the X.25 
commands diagnosed?

Refer to the Problem Determination Guide at http://www.eicon.com/
support/helpweb/connt/PDmenu.htm for Eicon Card X.25 command 
diagnostics.

Table 6   Frequently asked questions (continued)

Question Answer
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The raw ICM messages sent and received by LinkPlexer 1.2 are written to a single 
file called LP_SndRecvCurr.log stored in the Log folder. When the log file 
reaches the dynamic limit defined in the configuration file then a backup copy of 
the log file called LP_SndRecvPrev.log is created and the current log file is 
emptied. This tracing can be turned on by setting the configuration file entry 
IcmMessageLogging to ON. The size of the ICM message trace log file will 
be limited by the parameter IcmMessageLogFileSizeMegs in the 
configuration file.

There are rare scenarios whereby fatal error encounter during the startup are not 
recorded to the log file. To prevent this, there is an error file which is generated to 
store fatal errors encountered by LinkPlexer 1.2. This file called 
LP_Fatal_Error.log will be stored in the Log folder.

Log File Examples

Figure 33 is an example of LP_Curr.log. LP_Prev.log.The time and date are 
displayed to the left of the log file. The first entry, after the time, is the thread 
name, the second entry is the log type i.e. information message or warning 
message followed by the log message.
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Figure 33   LP_Curr.log file format
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Figure 34 is an example of LP_SndRcvCurr.log. In this file hex dumps of the ICM 
messages to and from the switch are logged to the file.

Figure 34   LP_SndRcvCurr.log file format

The fatal error file displays information on rare scenarios that are encountered 
during startup. A fatal error is identified, at startup by the dialog box in Figure 36. 
Figure 36gives an example of this file
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Figure 35   Fatal Error Dialog Box

Figure 36   LP_Fatal_Error.log file format

LinkPlexer 1.2 Procedures

This section looks at LinkPlexer 1.2 procedures of operation. It contains the 
following sections:

• “Backup of LinkPlexer 1.2 to enable restoration - in the event of a faulty PE
on page 94

• “PEP Installation” on page 95

Note: Log entries are tagged by IP address and port where appropria
facilitate tracking of message origin.
Note: All logging files are to milli-second resolution.
Note: The log file captures are examples only. Content may differ in 
individual LinkPlexer 1.2 operations.
LinkPlexer 1.2 Installation and Configuration Guide



94 Chapter 7 Maintenance & Troubleshooting LinkPlexer

 

le 
les.

 on 

er 
• “Back-up of LinkPlexer 1.2 and Restoration to a New Server” on page 98

• “Upgrade Procedure for LinkPlexer 1.1 to LinkPlexer 1.2” on page 99

• “Startup Procedures for Nortel Networks Call Centre Equipment” on 
page 102

• “Guidelines for the use of Anti-Virus software on LinkPlexer 1.2” on 
page 104

Backup of LinkPlexer 1.2 to enable restoration - in the event 
of a faulty PEP

Builds affected

All Builds and PEPs

Background

The LinkPlexer 1.2 file content may be updated or added to by the use of the
LinkPlexer 1.2 PEP installer. This will read the LinkPlexer 1.2 Path from the 
registry keys and install the modifications in the Nortel LinkPlexer 1.2 folder.

However in the case that there is a fault in the PEP installation and/or PEP fi
content, it is advisable to have a backup copy of the original LinkPlexer 1.2 fi

Procedure

1 Locate the LinkPlexer 1.2 folder. By default this is located in C:\Program 
Files\Nortel\LinkPlexer 1.2

2 Copy this folder (and consequently all the files) to another location

3 Close all applications that are currently running

4 Proceed with the PEP installation (refer to the PEP Installation procedure
page 91)

1 If there has been a problem with the PEP installation, delete the LinkPlex
1.2 folder located, by default, at C:\Program Files\Nortel\LinkPlexer 1.2

2 Restore the LinkPlexer 1.2 folder to C:\Program Files\Nortel

3 LinkPlexer 1.2 and its associated applications may be run as usual now.



Chapter 7 Maintenance & Troubleshooting LinkPlexer 95

tp://
d 

e 
 

PEP Installation

Builds affected

All builds and PEPs

Background

The LinkPlexer 1.2 file content may be updated or added to by use of the 
LinkPlexer 1.2 PEP (Product Enhancement Package) installer. This will read the 
LinkPlexer 1.2 Path from the relevant registry keys and install the modifications 
in the Nortel LinkPlexer 1.2 folder (default C:\Program Files\Nortel\LinkPlexer 
1.2.

The latest PEP for a particular build is available from http://
sulaco.europe.nortel.com:8080/mpl/core_mm_view.cfm where under each build 
folder there is a list of pertinent PEPs. The latest PEP for a given software build 
(e.g. 01.01.10) will always contain all the fixes/changes contained in earlier PEPs 
for the same build. Thus, only the latest PEP need be applied to the release.

It is advisable to follow the procedure “Backup of LinkPlexer 1.2 to enable 
restoration - in the event of a faulty PEP” prior to beginning this procedure.

Procedure

Assumptions:

• LinkPlexer 1.2 is installed

• All unassociated applications are closed

1 Locate the correct PEP for the installed build on the following website: ht
sulaco.europe.nortel.com:8080/mpl/core_mm_view.cfm. Unzip the file an
click on the setup icon (setup.exe)

2 The dialog box in Figure 37 shows, as an example, the InstallShield Welcom
dialog box for PEP LP010110G004. (Note, the same format will apply for
LinkPlexer 1.2).
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 37   LinkPlexer 1.1 PEP Installation - welcome dialog box 

3 Click Next. The PEP files will now be installed into the LinkPlexer 1.2 folder 
(by default this is C:\Program Files\Nortel\LinkPlexer 1.2)

4 After installation, the following dialog box, as in Figure 38, will be visible. 
Note, this is for a LinkPlexer 1.1 PEP, however a LinkPlexer 1.2 PEP will be 
of similar format.
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Figure 38   LinkPlexer 1.1 PEP Installation - finish dialog box

5 Click Finish. The PEP has now been installed. The Tracker application can be 
used to verify the PEP.

6 Tracker may be launched from Start\Programs\Programs\Nortel LinkPlexer 
1.2\Tracker. It will display the PEP level and the date as illustrated in 
Figure 39.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 39   Tracker with PEP details (for LinkPlexer 1.1)

Back-up of LinkPlexer 1.2 and Restoration to a New Server

Builds affected

All builds and PEP’s.

Background

This procedure documents the steps to take in order to ensure that the curre
configuration of LinkPlexer 1.2 (and hence the LinkPlexer files) is backed up
also outlines the steps to restore LinkPlexer to a new server in the case of a 
damage to the original server.

Procedure

1 Locate the LinkPlexer 1.2 folder. By default this is located in C:\Program 
Files\Nortel\LinkPlexer 1.2

2 Copy this folder (and consequently all the files) to another location. This s
ensures that there are backup copies of all the installed files.

3 Make a separate copy of the LPConfig.ini configuration file, which has be
adapted locally for LinkPlexer 1.2 configuration. A copy of this file should 
held externally e.g. on a separate machine.
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4 Install LinkPlexer 1.2 on the new server (follow Chapter 2, “Pre- Installation 
Requirements & Procedures,” on page 27 and Chapter 3, “Installing 
LinkPlexer 1.2,” on page 31).

5 Locate the LinkPlexer 1.2 folder. By default this is located in C:\Program 
Files\Nortel\LinkPlexer 1.2.

6 Retrieve the copied LPConfig.ini - copy this into the LinkPlexer 1.2 folder
over the default LPConfig.ini file.

7 The TCP/IP or X.25 connections must be re-configured. Refer to 
“Configuring LinkPlexer 1.2” on page 49 and “TCP/IP Connections” on 
page 56. 

Upgrade Procedure for LinkPlexer 1.1 to LinkPlexer 1.2

Builds

LinkPlexer Release 1.1 (all builds and PEPs) and all LinkPlexer 1.2 builds an
PEPs

Background

The following guidelines outline the necessary steps for upgrading the applica
from Release 1.1 to Release 1.2

Procedure

1 Locate the LinkPlexer 1.1folder. By default this is located in C:\Program 
Files\Nortel\LinkPlexer 1.1

2 Copy this folder (and consequently all the files) to another location. This s
ensures that there are backup copies of all the Release 1.1 files, in case 
fault during LinkPlexer 1.2 Installation.

3 Make a separate copy of the DMSGlobal.ini and DMSLocal.ini configurati
files, which have been adapted locally for LinkPlexer 1.1 configuration. A
copy of these file should be held externally i.e. on a separate machine fo
reference when completing the configuration for LinkPlexer 1.2. Note, 
although the format of the LinkPlexer 1.1 files are different to the format f
the LinkPlexer 1.2 configuration file, there is mutual information. Refer to
LinkPlexer 1.2 Installation and Configuration Guide
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“Appendix D: LinkPlexer Configuration Changes” on page 122 for the 
differences between LinkPlexer 1.1 and LinkPlexer 1.2 configuration files

4 Uninstall LinkPlexer 1.1, by clicking on Start\Settings\Control Panel\Add/
Remove Programs and selecting Nortel LinkPlexer 1.1.

5 LinkPlexer 1.2 can be installed and configured as directed in Chapter 3, 
“Installing LinkPlexer 1.2,” on page 31 and Chapter 4, “Configuring 
LinkPlexer 1.2,” on page 49.

6 If LinkPlexer 1.2 is to co-reside with LinkPlexer 1.1 then proceed as 
instructed from step 1 to 3. However there is one change that needs to b
made with regards to the system Services to enable LinkPlexer 1.2 opera
when co-resident with LinkPlexer 1.1.

7 Open the Services dialog box Start\Settings\Control Panel\Adminstrative
Tools and select Nortel LinkPlexer 1.1.

8 Right click and open the properties dialog box and change the startup typ
from Automatic to Manual as in Figure 40.
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Figure 40   LinkPlexer 1.1 Services Properties Dialog Box

9 The Services dialog box will now have LinkPlexer 1.2 with automatic startup 
and LinkPlexer 1.1 with Manual as indicated in Figure 41.
LinkPlexer 1.2 Installation and Configuration Guide
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Figure 41   Services with LinkPlexer 1.2 Coresident with LinkPlexer 1.1

Startup Procedures for Nortel Networks Call Centre 
Equipment

Builds affected

All Builds and PEPs

Background

This procedure defines the sequence for starting up call centre equipment

Procedure

When restarting Nortel Networks call centre equipment the following is the 
recommended sequence:

1 Start the Nortel Networks LinkPlexer 1.2 service

2 Start the services on the SCCS server (all services must be started before 
proceeding to the next step)
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3 Start the ACD proxy service on the TAPI server (this will also start Telephony 
Services). Note, ensure Call Monitor is running - a restart may be necessary

4 Start the Nortel Networks Startup Services on the Peri Link Server (this 
establishes the socket connection to the TAPI server)

5 Make test calls into the VPS system to ensure the calls are being handled 
correctly

If there is to be a planned outage to the SCCS - for full backups or PEP 
installations, the order in which the systems are brought down should start at step 
4 and go to step 1.

The following steps demonstrate how to stop the services:

1 On the Peri Link server open the Services for the server and select the 
Periphonics Startup Services and click Stop

2 On the TAPI server, at the Run line type killtapi. This will shutdown the ACD 
proxy and Telephony Services.

3 If performing a Full Backup of the SCCS server, wait for the services to stop 
and go to the next step (step 4). If a PEP is being installed on the server, wait 
for the services to stop or for the server to start the reboot process before 
proceeding to the restarting sequence

4 After the SCCS services have stopped, or the server is rebooting, open the 
Services for the server and select Nortel LinkPlexer 1.2 and click Stop. This 
will disconnect the link with the switch. Note, the link needs to be 
reestablished by restarting the LinkPlexer 1.2 Service before the SCCS tries to 
restart.

Precautions

The end user should be aware of the following scenarios when restarting the call 
centre or during an outage situation:

1 If a caller is receiving music or RANS’s and the SCCS is taken down or 
looses control of a CDN during call processing, the caller will not be place

Caution: Do not hard reboot the Peri Link
LinkPlexer 1.2 Installation and Configuration Guide
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back into the default routing of the switch. At this point, the switch is still 
looking for a message to terminate the call handling. All new callers or callers 
not receiving the above treatments, will be defaulted to the switch where they 
will not receive any treatments when their call arrives at the switch.

2 If either of the Peri Link, ICM TAPI or SCCS applications go down, the other 
applications will stop receiving messages about the resources being shared. 
This also includes CDN’s and associated ACD queues.

The affected applications can recover by reacquiring the resources in the
switch, this would involve manual intervention by the site administrator.

3 In the case of a LinkPlexer failure, all applications will loose control of the
acquired resources and the calls return to the switch default routing..

Guidelines for the use of Anti-Virus software on LinkPlexer 
1.2

It should be noted that the risk of virus infection on the LinkPlexer 1.2 server
minimal due to the limited access required for support of the server. LinkPlex
1.2 is compatible with and supports anti-virus software with known and 
documented guidelines. 

Nortel Networks has carried out testing on a representative sample of Anti-vi
software packages (Norton, McAfee and Innoculate) in order to determine ge
guidelines for the use of Antivirus software:

• The LinkPlexer server software must be installed before installing the 
Anti-Virus software. When the Anti-Virus software is installed, it is the 
implementation personnel’s responsibility to perform testing.

• During PEP installations all Anti-Virus functionality should be disabled an
should not startup automatically until the entire installation procedure is 
completed. Re-enable afterwards as required.

• Infected file quarantine policy on the LinkPlexer 1.2 server: the anti-virus 
software should not be configured to deal automatically with suspected 
infected files. In the event of infected files being located, there should be 
attempt to replace or remove them. Contact the local Nortel Support 
representative for assistance in determining if the file(s) are part of the 
LinkPlexer 1.2 application or a critical system file.
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• It is strictly unsupported to connect the LinkPlexer 1.2 server directly to th
Internet for the downloading of Virus definitions or updated files. Instead,
Virus definitions and update files should be downloaded to another locati
on the customer network, and manually loaded to the LinkPlexer 1.2 serv
This is the same recommended procedure for downloading Symposium P
This limits access to the Internet, and thus reduces the risk or downloadin
infected files.

• In addition, all PEP files, CD-ROMs and floppy disks should be scanned p
to installation or uploading to the server. This will minimise any exposure
infected files from outside sources.

• Capacity considerations: Customers should note that running virus scan 
software can place an additional load on the LinkPlexer 1.2 server. It is th
implementation personnel’s responsibility to run the WINNT 4.0 Performan
Monitor tool on the server to gauge CPU utilisation. If the Anti-Virus 
software scan causes the LinkPlexer 1.2 server average CPU utilisation t
become excessive then that Anti-Virus software should not be loaded ont
LinkPlexer 1.2 server.

Note: Nortel does not provide support on the configuration of anti-viru
scan software. Questions or problems on Anti-Virus software should b
directed to the appropriate vendor.
Note: The above recommendations are intended as guidelines only, 
do not constitute a guarantee of compatability. Nortel does not plan to
perform ongoing compatability testing, or testing on other Anti-Virus 
packages.
Note: If performance or functionality issues are raised to Nortel suppo
as part of the fault diagnosis process, the customer/distributor may be
asked to remove third party utility software or Anti-Virus software.
LinkPlexer 1.2 Installation and Configuration Guide
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Appendix A: Installation of the Eicon X.25 Card

This Appendix refers to Chapter 6, “Installing and configuring the Eicon X.25 
card, and the section “Installing the Eicon X.25 card” on page 82.

The following sequence of Screenshots can be used as a template for config
the Eicon card for use with LinkPlexer 1.2.

a X.25: General - values as in Figure 42
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Figure 42   Eicon Configuration X.25:General

b X.25: VC - values as in Figure 43
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Figure 43   Eicon Configuration X.25:VC

c X:25: Timers - values as in Figure 44
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Figure 44   Eicon Configuration X.25: Timers

d X.25: Advanced - values as in Figure 45
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Figure 45   Eicon Configuration X.25:Advanced

e HDLC: General - values as in Figure 46
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Figure 46   Eicon Configuration HDLC: General

f HDLC: Advanced - values as in Figure 47
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Figure 47   Eicon Configuration HDLC:Advanced

g Direct - values as in Figure 48
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Figure 48   Eicon Configuration Direct

h Synch: General - values as in Figure 49
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Figure 49   Eicon Configuration Synch:General

i Synch: Delay - values as in Figure 50
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Figure 50   Eicon Configuration Synch:Delay

Appendix B: DMS/MSL100 Table Definitions & Examples

This Appendix refers to “Configuring the DMS/MSL-100 switch” on page 57. It 
provides the table definitions and examples of the table contents that are rele
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BGDATA

Table BGDATA is used to store information relating to multiswitch business 
groups (MBG). This table sets the customer group that the linkset will be able to 
access. If a line is in another customer group than the one defined in this table the 
call center will not be allowed to acquire/monitor the line or ACD group

BGID BGXLA OPTIONS

LOCAL 2 $ (CUSTGRP TAS1 N 24 Y 0 0) $

SCAICOMS

Table SCAICOMS defines a linkset for use by a switch/computer applications 
interface (SCAI) group. This table sets the type and address of the host 
application. Most of the sites will be TCP type. The IPADDRESS in this table 
MUST match the IP of the host application or the switch will not allow login. The 
ENHASSOC feature allows for a max of 100 CDN’s to be acquired on this lin

LINKSET SCAILINKS OPTIONS

NORTEL TCP 47 104 99 88 N (ENHASSOC 100) $

SCAIGRP

Table SCAIGRP stores all the switch computer application interface (SCAI) 
groups within a switch. Each SCAI group has a password, network node iden
(ID) and business group ID (BGID). This table sets the login options for the 
linkset. The PASSWORD, NETNODID and BGID must be unique. The passw
and netnodid are defined only in this table. The BGID is the one datafilled in t
BGDATA

SCAIDNAM PASSWORD NETNODID BGID OPTIONS

NORTEL ABC123 1 LOCAL 2 (LINKSET (NORTEL) $)$
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SCAIPROF

Table SCAIPROF serves as a lookup table for switch computer application 
interface (SCAI) CompuCALL service profiles. A service profile is a set of 
CompuCALL messages and associated options that are available during a 
HIGHEST level of messaging that the link can support. The Subservice must be 
datafilled in table SCAISSRV in order to put it in this table. The Service ID is also 
datafilled in this table as part of the KEY Field.

NORTEL 1(CTXEVENT13$) (ACDEVENT12$) (ROUTING35$) (TPCC14$) 
(RESOURCE11$) (TPAC12$) (CALLINIT07$) (SCAI3WC14£) 
(SCAIMWTI13$) (DNQUERY07$) (SCAICC08$) (TPQC10$) (ICCM10$) 
(CPEVENT14$)$

Note: The $ after the subservice name denotes a default subservice that was
already datafilled in table SCAISSRV.

SCAISSRV

Table SCAISSRV acts as a reference table for CompuCALL service categori
This table sets the type of data you will get during the call flow for each type 
CompuCALL message. This table can be changed, but it is highly suggested
it not be changed from the default without careful engineering and customer 
flow consideration

CTXEVENT12$ CTXEVENT (SETOFFHK Y Y Y) (CALLOFFR Y Y Y Y Y Y 
Y Y Y Y Y Y Y Y) (CALLANSWR Y Y Y Y Y Y Y Y Y Y Y Y Y Y Y) 
(CALLREL Y Y Y Y) (CALLNAME Y Y Y Y Y)$

CUSTNTWK

Table CUSTNTWK is used to define options available to the customer group
This table only needs one option added to the customer group that was defin
table BGDATA. The option ECM must be assigned to the customer group so 
NON-ACD lines with the option ECM added to them in servord can be control
or monitored with the CTI.

CUSTNAME NETNAME NETCGID DNREVXLA OPTIONS
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TAS1 PRIVATE 1 $ (CLID INTRAGRP) (ECM) (NTWKEMW) (RNID 
INTRAGRP) $

LIUINV

Table LIUINV contains the configuration data for each ASU in an LPP or ELPP. 
The EIU is an interface between the DMS-bus and an Ethernet local area network 
(LAN). The MAC address in this table has to come from the program manager for 
the site.

LIUNAME LOCATION LOAD PROCINFO CARDINFO

EIU 2 MS 12 0 2 8 ETC15BC NTEX22BB NT9X84AA NT9X8522 NO 
000075F01AD0

IPNETWRK

The IPNETWRK table describes the CM node and default EIU. Table LIUINV 
must be datafilled before table IPNETWRK. Changes made to the IP address 
component in table IPNETWRK force automatic reconfiguration of the IP address 
components of all nodes listed in tables IPHOST and IPROUTER. SCRNFLAG 
must always be set to N. By default all ICMP messages will go out the first EIU 
datafilled in this table. In this case it would be tuple 0. This IPAddress of 0 is the 
ELAN IP for the call centre. All telnet and ftp connections will take place on the 
second EIU in this table. Only two EIU’s can be datafilled or physically insert
in the switch for a SNSE. Adding a third EIU will cut the amount of bandwidth
into 3 equal pipes, even though the third one is not in service.

KEYREF CMIPADDR SUBNET OPTION PARMAREA

0 156 42 126 193 8 $ (SCRNFLAG N) (EIU_INTERFACE EIU 2)$ 1 156 42 19
8 $ (SCRNFLAG N) (DFLT_GTWY_IPADDR 156 42 4 252) (EIU_INTERFACE
EIU 13) (DFLT_INTERFACE Y) $

IPHOST

The IPHOST table is responsible for configuring DMS nodes as Internet host
activates the TCP layer and its applications on those nodes. For interface EI
only datafill the CM in this table.
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INDEX NODENAME NODEINFO

0 CM 0 47 8 8

IPTHRON

Table IPTHRON contains IP THROttling numbers. The IP message flow from 
switch hosts requires throttling to control message congestion in the 
bandwidth-limited shared communication resources between the local message 
switch (LMS) and message switch (MS). The IP throttling numbers datafilled in 
this table derive the level of such throttling to and from each of the IP hosts.

Throttling capacity fields should not be zeros, the IP throttling numbers default to 
zero (100% throttling) for all EIUs datafilled in table LIUINV. If the throttling 
capacity numbers are not datafilled to non zero values, the EIU cannot 
communicate to destination nodes.

LMSNODE TXCAPCT RXCAPCT OPTION

EIU 2 32000 32000 (CM 32000) $

EIU 13 32000 32000 $

Appendix C: DN Association Management Examples

The following figures (demonstrate examples of “DN Association Management” 
on page 19, using Message Sequence charts.
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Figure 51   DN Association Management - Example 1
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Figure 52   DN Association Management - Example 2

Appendix D: LinkPlexer Configuration Changes

As discussed in “LinkPlexer 1.2 Configuration” on page 49, there has been 
configuration file changes made between LinkPlexer 1.1 and LinkPlexer 1.2. 
following changes have been made:
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IP address to Host Name Resolution

LinkPlexer 1.1 performed a lookup on the IP address entered in the configuration 
file to obtain a host name for display purposes. On some networks the look-up 
process was unacceptably slow (~20 seconds). When configured with SCCS 
acting as a session controller, the slow response can lead to failure of LinkPlexer 
1.1 successfully completing the logon process initiated by SCCS. This feature has 
been removed in LinkPlexer 1.2

Configuration Keywords

The following configuration keywords are no longer supported:

DNAssocFilter

SessionPort

ListenerPort

Configuration Entries Renamed

Table 7 indicates the configuration entries that have been renamed

Appendix E: LinkPlexer Comparison Matrix

The following matrix compares the features of LinkPlexer 1.2 with the LinkPlexer 
1.1 feature set.

Table 7   Renamed LinkPlexer 1.1Configuration Entries

LinkPlexer 1.1 LinkPlexer 1.2

Type Switch

DMSAddress SwitchAddress

DMSPort SwitchPort

RequestTimeout SwitchReplyTimeoutMilliSecs

HexTraceLevel IcmMessageLogging
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Table 8   Comparison between LinkPlexer 1.1 and LinkPlexer 1.2 features

Description Functional Comparison between 1.1 and 1.2

Windows NT Service Architecture No Change between 1.1 and 1.2

ICM Application Multiplexing No Change between 1.1 and 1.2

DN Association Sharing Existing 1.1 functionality enhanced as discussed in 
“DN Association Management” on page 19

Connectivity of ICM client to 
CompuCall

No Change between 1.1 and 1.2

Session Management DN Assoc filtering no longer supported. External 
session management no longer supported

Client Connection Management No Change 

PEP Installation and Tracking No Change 

Software Version Control No Change 

Software License Control No Change

Supportability Options All DMSerrorX.log files have been amalgamated 
into a single file LP_Curr.log, as discussed in “Log 
files” on page 89
DMSsendX.log and DMSrecvX.log files have been 
amalgamated into LP_SndRcvCurr.log, as 
discussed in “Log files” on page 89
Log file sizes are now configurable (in 
configuration file) and dynamic, as discussed in 
“LinkPlexer 1.2 Configuration” on page 49

Configuration DMSLocal.ini and DMSGlobal.ini no longer 
supported and have been replaced by 
LPConfig.ini, refer to“LinkPlexer 1.2 Configuration” 
on page 49 

DMS/MSL-100 No Change 

Co-residency Co-residency support based on target Operating 
System, as discussed in“Co-residency” on 
page 23

Microsoft Windows Operating 
System

Windows NT 4.0/2000 server supported. No 
checking done at install time.

Symantec pcAnywhere Now support for pcAnywhere 10.5, refer to 
Chapter 5, “Installing and configuring 
pcAnywhere,” on page 65

TCP/IP No Change 

X.25 No Change -supported
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Appendix F: Softphone Message Sequence Chart

This section refers the feature “Generation of dv-Set-Offhook-U on behalf of 
Softphone” on page 22. Figure 53 shows the Message Sequence Chart that 
demonstrates the message sequencing for the proposed solution.

Minimum Server Specification Server specification increased to support minimum 
specification for Windows 2000

Installation and Upgrade LinkPlexer 1.2 will not check for target operating 
system

Engineering Guidelines Engineering data will be captured as part of the 
Validation cycle nd used to provide guidelines for 
operation and co-residency

Maintainability Updates to support pcAnywhere 10.5

Installability/Upgrades No Change 

Reliability No Change

Table 8   Comparison between LinkPlexer 1.1 and LinkPlexer 1.2 features

Description Functional Comparison between 1.1 and 1.2
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Figure 53   Softphone feature Message Sequence Chart
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